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Safety warning notice

/A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Product Name

HP ProBook 4710s Notebook PC

Intel® Core™2 Duo T5870, 2.0 GHz, 2-MB L2 cache, 667-MHz Front Side Bus
(FSB)

Processors

Intel Core2 Duo T6570, 2.1 GHz, 2-MB L2 cache, TJ 100, 800-MHz FSB

Intel Core2 Duo T6670, 2.2 GHz, 2-MB L2 cache, 800-MHz FSB

Intel Core2 Duo P7370, 2.0 GHz, 3-MB L2 cache, 1066-MHz FSB

Intel Core2 Duo P7570, 2.26 GHz, 3-MB L2 cache, 1066-MHz FSB

Intel Core2 Duo P8600, 2.4 GHz, 3-MB L2 cache, 1066-MHz FSB

Intel Core2 Duo P8700, 2.53 GHz, 3-MB L2 cache, 1066-MHz FSB

Intel Core2 Duo T9400, 2.53 GHz, 6-MB L2 cache, 35W, 1066-MHz FSB

Intel Core2 Duo T9600, 2.8 GHz, 6-MB L2 cache, 1066-MHz FSB

Intel Pentium® Dual-Core T4200 2.00 GHz, 1-MB L2 cache, 800-MHz FSB

Intel Pentium Dual-Core T4300 2.16 GHz, 1-MB L2 cache, 800-MHz FSB

Intel Pentium Dual-Core T4400 2.20 GHz, 1MB L2 cache, 800-MHz FSB)

Intel Celeron® 585, 2.16 GHz, 2-MB L2 cache, 800-MHz FSB

Intel Celeron 900, 2.20 GHz, 1-MB L2 cache, 800-MHz FSB

Intel Celeron Dual-Core T1600, 1.66GHz, 1-MB L2 cache, 667-MHz FSB

Intel Celeron Dual-Core T1700 1.83-GHz, 1-MB L2 cache, 667-MHz FSB

Intel Celeron Dual-Core T3000 1.8 GHz, 1-MB L2 cache, 800-MHz FSB

Intel Celeron Dual-Core T3100 1.9 GHz, 1-MB L2 cache, 800-MHz FSB

Chipset

Northbridge: PM45 with up to 1066-MHz FSB

Southbridge: Intel ICH-OM

Graphics

AMD Discrete Graphics ATI-M92S2LP with Hypermemory support

512-MB DDR2-500MHz (64Mx16, Qty 4)

Panels

All display assemblies include 2 wireless local area network (WLAN) antennas

17.3-inch HD+ BrightView

17.3-inch HD+
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Category

Description

e  17.3-inch HD+ BrightView with camera

° 17.3-inch HD+ with camera

Memory 2 customer-accessible/upgradable memory module slots
Supports dual-channel memory
Supports up to 8 GB of system RAM
PC2-6400, 800 MHz, DDR2
Supports the following configurations:
e  8192-MB total system memory (4096 x 2, dual-channel)
e  4096-MB total system memory (4096 x 1)
e  4096-MB total system memory (2048 x 2, dual-channel)
e 3072-MB total system memory (2048 + 1024)
e  2048-MB total system memory (2048 x 1)
e  2048-MB total system memory (1024 x 2, dual-channel)
e  1024-MB total system memory (1024 x 1)
PC3-10600, 1333 MHz, DDR3
Supports the following configurations:
e  8092-MB total system memory (4096 x 2, dual-channel)
e  4096-MB total system memory (4096 x 1)
e  4096-MB total system memory (2048 x 2, dual-channel)
e 3072-MB total system memory (2048 + 1024, dual-channel)
e  2048-MB total system memory (2048 x 1)
e  2048-MB total system memory (1024 x 2, dual-channel)
e  1024-MB total system memory (1024 x 1)

Hard drives Supports 9.5-mm (2.5-inch) hard drives

Customer-accessible

Serial ATA

Supports the following drives:

e 500-GB, 7200-rpm

320-GB, 5400-rpm
e  320-GB, 7200-rpm
e  250-GB, 5400-rpm
e  250-GB, 7200-rpm

e 160-GB, 7200-rpm

HP 3D DriveGuard

Chapter 1 Product description



Category

Description

Optical drives

Fixed (removal of 1 screw required)

Customer-accessible

Serial ATA

12.7-mm tray load

Supports the following drives:
e DVD*RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe
e  Blu-ray ROM with LightScribe DVD+RW SuperMulti DL Drive

e DVD-ROM Drive

Diskette drive

Supports external USB diskette drive only

Supports boot from external USB diskette drive

Audio HD+ audio-ADI1984AJCPZ
Integrated microphone
Stereo speakers (2)
Modem 56K v.92 MDC 1.5-inch data/fax modem with digital line guard
Ethernet Marvell 10/100/1000 Ethernet network interface card (NIC)
S3/S4/S5 wake on LAN: AC-yes
Wireless Integrated WLAN options by way of wireless module:

2 WLAN antennas built into display assembly

Support for no-WLAN option

Support for the following WLAN formats:

e Broadcom 4322 802.11a/b/g/n

e Broadcom 4312 802.11b/g

e Intel 5100 802.11a/b/g

e Intel 5100 802.11a/b/g/n

e Intel Wi-Fi Link 1000, 802.11b/g

e Intel Wi-Fi Link 1000, 802.11b/g/n

e Broadcom 43224AGN 802.11a/b/g/n 2x2 WiFi Adapter

e  Atheros 9285G 802.11b/g/n WiFi Adapter

Integrated personal area network (PAN) options by way of Bluetooth® module:

Support for no-WPAN option

Bluetooth 2.0

Bluetooth 2.1

Media Card Reader

One ExpressCard/34 slot
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Category

Description

Media Card Reader supporting Memory Stick (MS), Memory Stick Pro (MSP),
MultiMediaCard (MMC), MultiMediaCard (MMC) Plus, Secure Digital (SD) Memory
Card, Secure Digital High Capacity (SDHC) Memory Card, xD-Picture Card (XD), xD-
Picture Card (XD) Type H, and xD-Picture Card (XD) Type M

Ports

Audio-in (stereo microphone)

Audio-out (stereo headphone)

RJ-11 (modem)

RJ-45 (Ethernet, includes link and activity lights)

USB (4)

HDMI

VGA (Dsub 15-pin) supporting 1600 x 1200 external resolution at 75-GHz (hot plug/
unplug with auto-detect)

Multi-pin AC power

Keyboard/pointing
devices

17.3-inch keyboard with integrated numeric keypad

TouchPad only, with 2 TouchPad buttons and vertical scrolling (taps enabled as
default)

Power requirements

90-W Smart AC adapter with localized cable plug support (3-wire plug with ground
pin)

6-cell, 47-Wh Li-ion battery

8-cell, 63-Wh Li-ion battery

Security

Supports Kensington security lock

Operating system

Preinstalled:

e  Windows 7 Professional 32

e  Windows 7 Home Premium 32

e  Windows Vista® Home Basic 32

e  Windows Vista Home Premium 32

e  Windows Vista Business 32

e  Windows Vista Business 32 (with Windows® XP Pro images)
e FreeDOS

e Red Flag Linux (in the People's Republic of China only)

e  SUSE Linux

Restore media:

Chapter 1 Product description



Category

Description

Windows 7 Home Basic 32
Windows 7 Home Premium 32
Windows 7 Professional 32
Windows 7 Professional 64
Windows Vista Home Basic 32
Windows Vista Home Premium 32
Windows Vista Business 32
Windows Vista Business 64
Windows XP Professional

Red Flag Linux (in the People's Republic of China only)
SUSE Linux

Windows Vista (DRDVD)
Windows XP Pro (DRDVD)

Windows Vista (Office Ready; DVD)

Certified: Microsoft® WHQL

Web Support:

Windows Vista Home Basic 32

Windows Vista Home Premium 32

Windows Vista Business 32

Windows Vista Business 64

Windows XP Professional

SUSE Linux

Serviceability

End-user replaceable parts:

AC adapter

Battery (system)

Hard drive

Memory module

Optical drive

WLAN module




2 External component identification

Top components

Display components

L

Item Component Function

(1) Internal display switch Turns off the display if the display is closed while the
power is on.

(2) WLAN antenna locations Send and receive signals from one or more WLAN
devices.

NOTE: The antennas are not visible from the outside of
the computer. For optimal transmission, keep the areas
immediately around the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of
the Regulatory, Safety and Environmental Notices that
applies to your country or region. These notices are
located in Help and Support.

3) Internal microphone Records sound.

6 Chapter 2 External component identification



Item Component Function

(4) Webcam light (select models only) On: The integrated camera is in use.

(5) Webcam (select models only) Records audio and video and captures still photographs.

TouchPad

Item Component Function

(1) TouchPad* Moves the pointer and selects or activates items on the
screen.

(2) Left TouchPad button* Functions like the left button on an external mouse.

(3) TouchPad scroll zone Scrolls up or down.

(4) Right TouchPad button* Functions like the right button on an external mouse.

*This table describes factory settings. View or change pointing device preferences as follows:
e In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

° In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.

Top components 7
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Buttons, lights, and speakers

Item

Component

Function

(1)

Caps lock light

On: Caps lock is on.

(2

Speakers (2)

Produce sound.

(3)

Info Center/QuickLook button

Launches Info Center or QuickLook.

4

Info Center/QuickLook light

e  On: The computer is on.
e  Blinking (5 times):

° When the computer is on, press button to
launch Info Center.

o When the computer is off or in Hibernation,
press button to launch QuickLook.

e  Off: The computer is off or in the Standby or
Hibernation state.

Chapter 2 External component identification



Keys

Item Component Function
(5) Power light e  On: The computer is on.
e  Blinking: The computer is in the Sleep state
(Windows Vista) or Standby (Windows XP).
e  Off: The computer is off or in Hibernation.
(6) Power button e  When the computer is off, press the button to turn

on the computer.

e  When the computer is on, press the button to shut
down the computer.

e  When the computer is in Standby, press the button
briefly to exit Standby.

e  When the computer is in Hibernation, press the
button briefly to exit Hibernation.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.

3

Item Component Function

(1) esc key Displays system information when pressed in
combination with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

Top components



Item Component

Function

(5) Integrated numeric keypad keys Can be used like the keys on an external numeric keypad
when pressed in combination with the fn and num |k
keys.

(6) Function keys Execute frequently used system functions when pressed

in combination with the fn key.

10 Chapter 2 External component identification



Front components

Item

Component

Function

()

Drive light

° Blinking turquoise. The hard drive or optical drive is
being accessed.

e  Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

()

Wireless switch

Turns the wireless feature on or off, but does not
establish a wireless connection.

NOTE: A wireless network must be set up in order to
establish a wireless connection.

®)

Wireless light

e  On: An integrated wireless device, such as a
wireless local area network (WLAN) device, the HP
Broadband Wireless Module, and/or a Bluetooth
device, is on.

e  Off: All wireless devices are off.

(4)

Media Card Reader

Supports the following optional digital card formats:

e  Memory Stick (MS)

e  Memory Stick Pro (MSP)

e  MultiMediaCard (MMC)

e  MultiMediaCard (MMC) Plus

e  Secure Digital (SD) Memory Card

e  Secure Digital High Capacity (SDHC) Memory Card
e  xD-Picture Card (XD)

e  xD-Picture Card (XD) Type H

e  xD-Picture Card (XD) Type M

©)

Audio-out (headphone) jack

Connects optional powered stereo speakers,
headphones, ear buds, a headset, or television audio.

(6)

Audio-in (microphone) jack

Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

Front components
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Right-side components

Item

Component

Function

0

USB ports (2)

Connect optional USB devices.

(2

RJ-11 (modem) jack

Connects a modem cable.

3

Optical drive (select models only)

Reads optical discs and, on select models, also writes to
optical discs.

4)

Optical drive light (select models only)

On: The optical drive is being accessed.

(5

Battery light

Amber: A battery is charging.
Turquoise: A battery is close to full charge capacity.

Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the
battery light begins blinking rapidly.

Off: If the computer is plugged into an external
power source, the light turns off when all batteries in
the computer are fully charged. If the computer is
not plugged into an external power source, the light
stays off until the battery reaches a low battery level.

(6)

Power connector

Connects an AC adapter.
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Left-side components

Item

Component

Function

()

ExpressCard slot

Supports optional ExpressCards.

()

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(&)

RJ-45 (network) jack

Connects a network cable.

(4)

Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

©)

External monitor port

Connects an external VGA monitor or projector.

(6)

HDMI port

Connects an optional HDMI device.

@)

USB ports (2)

Connect optional USB devices.

Left-side components

13



Bottom components

SR
|

Item Component Function
1) Battery release latches (2) Release the battery from the battery bay.
(2) Battery bay Holds the battery.
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3 lllustrated parts catalog

Service tag

The service tag, affixed to the bottom of the computer, provides information that may be needed
when troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components
and parts are needed.

(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.

(5) Warranty period: Describes the duration of the warranty period for this computer.

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Computer major components

Item Description Spare part number
(1) Display assembly (includes 2 WLAN antenna transceivers and cables)
17.3-inch, HD+ BrightView display assembly with camera 535777-001
17.3-inch, HD+ BrightView display assembly 535779-001
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Item Description Spare part number
17.3-inch, HD+ display assembly with camera 535778-001
17.3-inch, HD+ display assembly 535776-001
Display internal components: (not illustrated)

Display bezel:

e Models equipped with a webcam 535769-001
e Models not equipped with a webcam 535770-001
Display Cable Kit (includes wireless antenna and webcam cables) 535771-001
Display hinges (left and right hinges) 535772-001

(2) Switch cover 535758-001

(3) Keyboard
For use in Arabia 535798-171
For use in Brazil 535798-201
For use in Bulgaria 535798-261
For use in Czech Republic 535798-221
For use in Denmark 535798-081
For use in Europe 535798-B31
For use in Europe A4 535798-A41
For use in French Canada 535798-121
For use in France 535798-051
For use in Greece 535798-DJ1
For use in Germany 535798-041
For use in Hungary 535798-211
For use in Iceland 535798-DD1
For use in Israel 535798-BB1
For use in Italy 535798-061
For use in Japan 535798-291
For use in South Korea 535798-AD1
For use in Latin America 535798-161
For use in Norway 535798-091
For use in Portugal 535798-131
For use in Russia 535798-251
For use in Sweden/Finland 535798-B71
For use in Slovakia 535798-231
For use in Spain 535798-071

Computer major components
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Item Description Spare part number

For use in Switzerland 535798-BG1
For use in Thailand 535798-281
For use in Turkey 535798-141
For use in Taiwan 535798-AB1
For use in United Kingdom 535798-031
For use in the United States 535798-001
(4) Palm rest (includes TouchPad) 535775-001
(5) RJ-45 (network) cable (included in Cable Kit, spare part number 535757-001)
(6) Speakers 535795-001
(7) Top cover 535796-001
(8) RJ-11 (modem) cable (included in Cable Kit, spare part number 535757-001)
(9) Fan 535766-001
(10) Heat sink (includes replacement thermal material) 535767-001
(11) System board (includes replacement thermal material and the ExpressCard assembly)
For use in computers with DDR2 memory 574508-001
For use in computers with DDR3 memory 583077-001

Processor (includes replacement thermal material) (not illustrated)

Intel Core2 Duo processors:

e T5870 (2.0 GHz, 800-MHz FSB, 2-MB L2 cache) 535835-001

e T6570 (2.1 GHz, 800-MHz FSB, 2-MB L2 cache, TJ 100) (not available for Japan; only 513598-001
available with Intel WLAN or no WLAN)

e T6670 (2.2 GHz, 800-MHz FSB, 2-MB L2 cache) 572927-001

e P7370 (2.0 GHz, 1066-MHz FSB, 3-MB L2 cache) (only available with Intel WLAN) 507966-001

e P7570 (2.26 GHz, 1066-MHz FSB, 3-MB L2 cache) 572930-001
e P8600 (2.4 GHz, 1066-MHz FSB, 3-MB L2 cache) 507961-001
e P8700 (2.53 GHz, 1066-MHz FSB, 3-MB L2 cache) 507960-001
e  T9400 (2.53 GHz, 1066-MHz FSB, 6-MB L2 cache, 35W) 507954-001
e  T9600 (2.8 GHz, 1066-MHz FSB, 6-MB L2 cache) 507952-001

Intel Pentium Dual-Core processors:

e  T4200 (2.0 GHz, 800-MHz FSB, 1-MB L2 cache) 513599-001
e  T4300 (2.16 GHz, 800-MHz FSB, 1-MB L2 cache) 572929-001
e  T4400 (2.20 GHz, 800-MHz FSB, 1MB L2 cache) 582496-001

Intel Celeron processors:

e 585(2.16 GHz, 800-MHz FSB, 2-MB L2 cache) 519898-001

e 900 (2.20 GHz, 800-MHz FSB, 1-MB L2 cache) 534419-001
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Item Description Spare part number
Intel Celeron Dual-Core processors:
e T1600 (1.66GHz, 667-MHz FSB, 1-MB L2 cache) 532324-001
e T1700 (1.83-GHz, 667-MHz FSB, 1-MB L2 cache) 534084-001
e  T3000 (1.8-GHz, 800-MHz FSB, 1-MB L2 cache) 572925-001
e T3100 (1.9-GHz, 800-MHz FSB, 1-MB L2 cache) 572926-001
(12) Battery connector board 535754-001
(13) Modem module
For use in all countries and regions except Australia and New Zealand 510100-001
For use only in Australia and New Zealand 510100-011
(14) Power button board and cable 574493-001
(15) Power connector and cable (included in Cable Kit, spare part number 535757-001)
(16) Optical disk drive connector board 535755-001
(17) WLAN module

Broadcom 4322 802.11a/b/g/n WLAN modules:

Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, 504664-001
Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and
Tobago, the U.S. Virgin Islands, and the United States

Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, 504664-002
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the
British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape
Verde, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong
Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the
Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

Broadcom 4312 802.11b/g WLAN modules:

Broadcom 4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, = 504593-003
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the
U.S. Virgin Islands, and the United States

Computer major components
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Item

Description

Broadcom 4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, 504593-004
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the
British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape
Verde, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong
Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan,
Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the
Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the
Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia,
St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United
Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia,
and Zimbabwe

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN modules:

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions  480985-001

Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in Russia and the Ukraine 482957-001

Atheros 9285G 802.11b/g/n WiFi Adapter WLAN modules:

Atheros 9285G 802.11b/g/n WiFi Adapter WLAN module for use in Antigua and 580101-001
Barbuda, Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico,
Trinidad and Tobago, the U.S. Virgin Islands, and the United States
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Item

Description

Spare part number

Atheros 9285G 802.11b/g/n WiFi Adapter WLAN module for use in Afghanistan, 580101-002
Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba,
Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus,
Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's
Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, ltaly, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN modules:

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and 572520-001
Barbuda, Argentina, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Barbados,
Belgium, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman
Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland,
France, French Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece,
Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland,
Israel, Italy, Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia,
Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Martinique,
Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Nigeria, Oman, Pakistan, Panama, Paraguay,
Peru, the Philippines, Poland, Portugal, Puerto Rico, Quatar, Romania, San Marino,
Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea,
Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and
Tobago, Turkey, United Arab Emirates, the United Kingdom, the United States,
Uruguay, the U.S. Virgin Islands, Venezuela, and Vietnam

Intel Wi-Fi Link 1000, 802.11b/g WLAN module for use in Russia and the Ukraine 585984-001

Broadcom 43224AGN 802.11a/b/g/n 2x2 WiFi Adapter WLAN modules:

Broadcom 43224AGN 802.11a/b/g/n 2x2 WiFi Adapter WLAN module for use in 582564-001
Antigua and Barbuda, Aruba, the Bahamas, Barbados, Belize, Canada, Guam,

Guinea, Haiti, Jamaica, the Nether Antilles, Puerto Rico, St. Kitts and Nevis, St. Lucia,

St. Vincent and the Grenadines, Suriname, the United States, and the U.S. Virgin

Islands

Computer major components
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Item

Description

Spare part number

Broadcom 43224AGN 802.11a/b/g/n 2x2 WiFi Adapter WLAN module for use in
Afghanistan, Albania, Algeria, Andorra, Angola, Argentina, Armenia, Australia, Austria,
Azerbaijan, Bahrain, Belarus, Belgium, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Cape Verde, Cayman Islands, the Central African
Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea-Bissau, Guyana, Honduras, Hong Kong, Hungary,
Iceland, India, Ireland, Italy, the Ivory Coast, Japan, Jordan, Kazakhstan, Kenya,
Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives,
Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru,
Nepal, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman,
Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, Qatar, the Republic of Moldova, Romania, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Vanuatu, Venezuela, Vietham, Yemen, Zaire, Zambia, and Zimbabwe

582564-002

(18)

Base enclosure (includes rubber feet)

535752-001

Rubber Kit (not illustrated, contains 7 computer feet and 8 display bezel screw covers)

535793-001

(19)

USB connector and cable (included in Cable Kit, spare part number 535757-001)

(20)

Bluetooth cable (included in Cable Kit, spare part number 535757-001)

(21)

Bluetooth module

Bluetooth 2.0 module

398393-002

Bluetooth 2.1 module

537921-001

(22)

RTC battery

449137-001

(23)

Hard drive (includes hard drive bracket)

500-GB, 7200-rpm

634920-001

320-GB, 5400-rpm

622643-001

320-GB, 7200-rpm

603783-001

250-GB, 5400-rpm

535763-001

250-GB, 7200-rpm

538972-001

160-GB, 7200-rpm

577972-001

(24)

Optical drive (includes bezel and bracket)

DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

535761-001

Blu-ray ROM with LightScribe DVD+RW SuperMulti DL Drive

535759-001

DVD-ROM Drive

535760-001

(25)

Memory modules
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Item Description Spare part number
For use in models that use DDR2 memory
e 1-GB (PC2-6400, 800-MHz, DDR2) 598861-001
e 2-GB (PC2-6400, 800-MHz, DDR2) 598858-001
For use in models that use DDR3 memory
e 2-GB (PC3-10600, 1333-MHz, DDR3) 598856-001
e 1-GB (PC3-10600, 1333-MHz, DDR3) 598859-001
(26) 8-cell, 63-Wh Li-ion battery 535753-001

Computer major components
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Display assembly components

ltem Description Spare part number

1) Display bezel
Display bezel with webcam 535769-001
Display bezel without a webcam 535770-001
Display Cable Kit, includes: 535771-001

(2a) Webcam module cable

(2b) Microphone cable

(2c) Wireless antenna transceivers and cables

(2d) Display panel cable
Display Hinge Kit, includes: 535772-001
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(3a) Display hinge bracket

(3b) Display left and right hinges

(4) Display enclosure 535768-001

Plastics Kit

0.7

F

Item  Description Spare part number
Plastics Kit: 535780-001
(1) ExpressCard slot bezel

(2) Optical drive bezel

Plastics Kit

25



Cable Kit

e

o

wFe—o

Item  Description Spare part number

Cable Kit 535757-001

1) TouchPad cable

(2) RJ-11 (modem) jack cable

(3) RJ-45 (network) jack cable

(4) Bluetooth cable

(5)  USB cable
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Mass storage devices

Item  Description Spare part number
(1) Optical drives (include bezel and bracket)
DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 535761-001
Blu-ray ROM with LightScribe DVD+RW SuperMulti DL Drive 535759-001
DVD-ROM Drive 535760-001
(2) Hard drives (include bracket)
500-GB, 7200-rpm 634920-001
320-GB, 5400-rpm 622643-001
320-GB, 7200-rpm 603783-001
250-GB, 5400-rpm 535763-001
250-GB, 7200-rpm 538972-001
160-GB, 7200-rpm 577972-001
Hard Drive Hardware Kit (not illustrated) 630891-001

Mass storage devices
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Miscellaneous parts

Description Spare part number
90W Smart AC Adapter RC/V 3W 613153-001
90W Smart AC Adapter RC/V EM 3W 613160-001
Power cords:

For use in the United States 246959-001
For use in Australia and New Zealand 246959-011
For use in Europe, the Middle East, and Africa 246959-021
For use in the United Kingdom 246959-031
For use in Italy 246959-061
For use in Denmark 246959-081
For use in Brazil 246959-201
For use in Japan 246959-291
For use in South Korea 246959-AD1
For use in Israel 246959-BB1
Screw Kit 535794-001
Screw Kit includes:

e  Phillips PM2.0%3.0 screw

e  Phillips PM2.0%4.0 screw

e Phillips PM2.5x3.0 screw

e  Phillips PM2.5x4.5 screw

e  Phillips PM2.5%5.0 screw

e  Phillips PM2.5x9.0 screw

e  Phillips PM2.5x10.0 captive screw

e  Phillips PM2.0%2.0 broadhead screw

e  Phillips PM2.0x3.0 broadhead screw

e  Phillips PM3.0x4.0 screw

e Torx T8M2.5x6.0 screw

Hard Drive Hardware Kit 630891-001
Battery Latch Kit (15.6/17.3) 602064-001
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Sequential part number listing

Spare part Description

number

246959-001 Power cord for use in the United States

246959-011 Power cord for use in Australia

246959-021 Power cord for use in Europe

246959-031 Power cord for use in the United Kingdom

246959-061 Power cord for use in Italy

246959-081 Power cord for use in Denmark

246959-201 Power cord for use in Brazil

246959-291 Power cord for use in Japan

246959-AD1 Power cord for use in South Korea

246959-AG1  Power cord for use in Switzerland

246959-BB1 Power cord for use in Israel

398393-002 Bluetooth 2.0 module for use in all countries and regions except Japan and Asia Pacific

449137-001 RTC battery

480985-001 Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions

482957-001 Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in Russia and the Ukraine

504593-003 Broadcom 4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada, the
Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United States

504593-004 Broadcom 4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua
and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and
Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietham, Yemen, Zaire,
Zambia, and Zimbabwe

504664-001 Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize, Canada,

the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the United
States
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504664-002

Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, ltaly, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and
Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

507952-001

Intel Core2 Duo T9600 processor (2.8 GHz, 1066-MHz FSB, 6-MB L2 cache)

507954-001

Intel Core2 Duo T9400 processor (2.53 GHz, 1066-MHz FSB, 6-MB L2 cache, 35W)

507960-001

Intel Core2 Duo P8700 processor (2.53 GHz, 1066-MHz FSB, 3-MB L2 cache)

507961-001

Intel Core2 Duo P8600 processor (2.4 GHz, 1066-MHz FSB, 3-MB L2 cache)

507966-001

Intel Core2 Duo P7370 processor (2.0 GHz, 1066-MHz FSB, 3-MB L2 cache) (Only available with Intel
WLAN)

510100-001

Modem module for use in all countries and regions except Australia and New Zealand

510100-011

Modem module for use only in Australia and New Zealand

513598-001

Intel Core2 Duo T6570 processor (2.1 GHz, 800-MHz FSB, 2-MB L2 Cache, TJ 100) (not available for
Japan. Only available with Intel WLAN or no WLAN)

513599-001

Intel Pentium Dual-Core T4200 processor (2.0 GHz, 800-MHz FSB, 1-MB L2 cache)

519898-001

Intel Celeron 585 processor (2.16 GHz, 800-MHz FSB, 2-MB L2 cache)

532324-001

Intel Celeron Dual-Core T1600 processor (1.66GHz, 667-MHz FSB, 1-MB L2 cache)

534084-001

Intel Celeron Dual-Core T1700 processor (1.83-GHz, 667-MHz FSB, 1-MB L2 cache)

534419-001

Intel Celeron 900 processor (2.20 GHz, 800-MHz FSB, 1-MB L2 cache)

535752-001

Base enclosure (includes rubber feet)

535753-001

8-cell, 63-Wh Li-ion battery

535754-001

Battery connector board

535755-001

Optical disk drive connector board

535757-001

Display Cable Kit (includes microphone, wireless antenna, display panel, and webcam cables)

535758-001

Switch cover

535759-001

Blu-ray ROM with LightScribe DVD+RW SuperMulti DL Drive
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535760-001 DVD ROM Drive

535761-001 DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe

535763-001 250-GB, 5400-rpm hard drive

535766-001 Broadcom Bluetooth module

535767-001 Heat sink (includes replacement thermal material)

535768-001 Display enclosure

535769-001 Display bezel with webcam

535770-001 Display bezel without a webcam

535771-001 Display Cable Kit

535772-001 Display hinge

535775-001 Palm rest with TouchPad

535776-001 17.3-inch, HD+ display assembly

535777-001 17.3-inch, HD+ BrightView display assembly with camera

535778-001 17.3-inch, HD+ display assembly with camera

535779-001 17.3-inch, HD+ BrightView display assembly

535780-001 Plastics Kit (includes ExpressCard slot bezel and optical drive bezel)

535793-001 Rubber Kit

535794-001 Screw Kit

535795-001 Speaker Kit

535796-001 Top cover

535797-001 Webcam module

535798-001 Keyboard for use in the United States

535798-031 Keyboard for use in the United Kingdom

535798-041 Keyboard for use in Germany

535798-051 Keyboard for use in France

535798-061 Keyboard for use in Italy

535798-071 Keyboard for use in Spain

535798-081 Keyboard for use in Denmark

535798-091 Keyboard for use in Norway

535798-121 Keyboard for use in French Canada

535798-131 Keyboard for use in Portugal

535798-141 Keyboard for use in Turkey

535798-161 Keyboard for use in Latin America

535798-171 Keyboard for use in Arabia
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535798-201

Keyboard for use in Brazil

535798-211

Keyboard for use in Hungary

535798-221

Keyboard for use in Czech Republic

535798-231

Keyboard for use in Slovakia

535798-251

Keyboard for use in Russia

535798-261

Keyboard for use in Bulgaria

535798-281

Keyboard for use in Thailand

535798-291

Keyboard for use in Japan

535798-A41

Keyboard for use in Europe A4

535798-AB1

Keyboard for use in Taiwan

535798-AD1

Keyboard for use in South Korea

535798-B31

Keyboard for use in Europe

535798-B71

Keyboard for use in Sweden/Finland

535798-BB1

Keyboard for use in Israel

535798-BG1

Keyboard for use in Swizerland

535798-DD1

Keyboard for use in Iceland

535798-DJ1

Keyboard for use in Greece

535835-001

Intel Core2 Duo T5870 processor (2.0 GHz, 800-MHz FSB, 2-MB L2 cache)

537921-001

HP Integrated Bluetooth 2.1 module for use in all countries and regions except Japan and Asia Pacific
countries and regions

538972-001

250-GB, 7200-rpm hard drive

572520-001

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, the Bahamas, Barbados, Belgium, Bolivia, Bosnia and Herzegovina,
Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, China, Colombia, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, the Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France,
French Guiana, Guadeloupe, Guam, Georgia, Germany, Ghana, Greece, Guatemala, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, ltaly, Ivory Coast, Jamaica, Japan, Jordan,
Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia,
Malta, Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands,
New Zealand, Nicaragua, Nigeria, Oman, Pakistan, Panama, Paraguay, Peru, the Philippines, Poland,
Portugal, Puerto Rico, Quatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia,
Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand,
Trinidad and Tobago, Turkey, United Arab Emirates, the United Kingdom, the United States, Uruguay, the
U.S. Virgin Islands, Venezuela, and Vietnam

572925-001

Intel Celeron Dual-Core T3100 processor (1.9-GHz, 800-MHz FSB, 1-MB L2 cache)

572926-001

Intel Celeron Dual-Core T3000 processor (1.8-GHz, 800-MHz FSB, 1-MB L2 cache)

572927-001

Intel Core2 Duo T6670 processor (2.2 GHz, 800-MHz FSB, 2-MB L2 cache)

572929-001

Intel Pentium Dual-Core T4300 processor (2.16 GHz, 800-MHz FSB, 1-MB L2 cache)

572930-001

Intel Core2 Duo P7570 processor (2.26 GHz, 1066-MHz FSB, 3-MB L2 cache)

574493-001

Power button board (includes cable)
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574508-001

System board for use in computers with DDR2 memory (includes replacement thermal material and the
ExpressCard assembly)

577972-001

160-GB, 7200-rpm hard drive

580101-001

Atheros 9285G 802.11b/g/n WiFi Adapter WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the
United States

580101-002

Atheros 9285G 802.11b/g/n WiFi Adapter WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas,
Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and
Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietham, Yemen, Zaire,
Zambia, and Zimbabwe

582564-001

Broadcom 43224AGN 802.11a/b/g/n 2x2 WiFi Adapter WLAN module for use in Antigua and Barbuda,
Aruba, the Bahamas, Barbados, Belize, Canada, Guam, Guinea, Haiti, Jamaica, the Nether Antilles, Puerto
Rico, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, the United States, and the
U.S. Virgin Islands

582564-002

Broadcom 43224AGN 802.11a/b/g/n 2x2 WiFi Adapter WLAN module for use in Afghanistan, Albania,
Algeria, Andorra, Angola, Argentina, Armenia, Australia, Austria, Azerbaijan, Bahrain, Belarus, Belgium,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, British Virgin Islands, Brunei,
Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde, Cayman Islands, the Central African
Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala,
Guinea-Bissau, Guyana, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory Coast,
Japan, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, Qatar, the Republic of Moldova, Romania, Rwanda, Samoa, San Marino, Sao Tome and
Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu,
Uganda, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

583077-001

System board for use in computers with DDR3 memory (includes replacement thermal material and the
ExpressCard assembly)

584296-001

Intel Pentium Dual-Core T4400 processor (2.20 GHz, 800-MHz FSB, 1MB L2 cache)
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585984-001

Intel Wi-Fi Link 1000, 802.11b/g WLAN module for use in Russia and the Ukraine

598856-001

2-GB memory module (PC3-10600, 1333-MHz, DDR3)

598858-001

2-GB memory module (PC2-6400, 800-MHz, DDR2)

598859-001

1-GB memory module (PC3-10600, 1333-MHz, DDR3)

598861-001

1-GB memory module (PC2-6400, 800-MHz, DDR2)

602064-001

Battery Latch Kit (15.6/17.3)

603783-001

320-GB, 7200-rpm hard drive

613153-001

90W Smart AC Adapter RC/V 3W

613160-001

90W Smart AC Adapter RC/V EM 3W

622643-001

320-GB, 5400-rpm hard drive

630891-001

Hard Drive Hardware Kit

634920-001

500-GB, 7200-rpm hard drive
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4 Removal and replacement procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:

° Flat-bladed screwdriver
e  Magnetic screwdriver
° Torx T8 screwdriver

e  Phillips PO and P1 screwdrivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

Bf NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

/\ CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.

Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors

/A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling

/\ CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.
Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-
proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

/A CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

/A CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000 V 800V 400 V
Removing DIPS from plastic tube 2,000V 700V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

Preliminary replacement requirements 37



Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
Place items on a grounded surface before removing items from their containers.
Always be properly grounded when touching a component or assembly.

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

Cover the workstation with approved static-shielding material.

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

Avoid contact with pins, leads, or circuitry.

Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

e When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm £10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

e When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
e Antistatic tape

e Antistatic smocks, aprons, and sleeve protectors

e Conductive bins and other assembly or soldering aids

e Nonconductive foam

e Conductive tabletop workstations with ground cords of one megohm resistance
e  Static-dissipative tables or floor mats with hard ties to the ground

e Field service kits

e  Static awareness labels

e Material-handling packages

e Nonconductive plastic bags, tubes, or boxes

e Metal tote boxes

e Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500V
Metallized laminate Floor mats 5,000V
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Component replacement procedures

This section provides removal and replacement procedures.

There are as many as 89 screws, in 15 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag

The service tag, affixed to the bottom of the computer, provides information that may be needed
when troubleshooting system problems. The service tag provides the following information:

(1) Product name: This is the product name affixed to the front of the computer.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/Product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components
and parts are needed.

(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.

(5) Warranty period: Describes the duration of the warranty period for this computer.

- product 000000000 X000
- s/ - xooccoceess  ITHRNIRTENARHRDANATH
L pdn : sccxenanooc | D0 L0 I
E‘,] SBIVICE | XX000o
tag | warranty x year.

m

00
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 535793-001 . There are 7 rubber feet that attach to the base enclosure in the locations

illustrated below.

-
1
I
I
I
I

o | — — —
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Battery

42

Description Spare part number

8-cell, 63-Wh Li-ion battery 535753-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1. Turn the computer upside down on a flat surface, with the battery bay toward you.
2. Slide the battery release latches (1) to release the battery.

3.  Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Switch cover and keyboard

Description Spare part number

Switch cover 535758-001

Keyboards for use in the following countries or regions:

Arabia 535798-171 Japan 535798-291
Brazil 535798-201 Latin America 535798-161
Bulgaria 535798-261 Norway 535798-091
Czech Republic 535798-221 Portugal 535798-131
Denmark 535798-081 Russia 535798-251
Europe 535798-B31 Slovakia 535798-231
Europe A4 535798-A41 South Korea 535798-AD1
France 535798-051 Spain 535798-071
French Canada 535798-121 Sweden/Finland 535798-B71
Germany 535798-041 Switzerland 535798-BG1
Greece 535798-DJ1 Taiwan 535798-AB1
Hungary 535798-211 Thailand 535798-281
Iceland 535798-DD1 Turkey 535798-141
Israel 535798-BB1 United Kingdom 535798-031
Italy 535798-061 The United States 535798-001

Before removing the switch cover and keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).
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Remove the switch cover and keyboard:

1.  Remove the following screws:
(1) Two screw covers and two Phillips PM2.5x3.0 screws
(2) Three Phillips PM2.0x3.0 broadhead screws
(3) Two Phillips PM2.0%3.0 screws

4
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2. Turn the computer right-side up, with the front toward you.

3.  Open the computer as far as possible.

4. Slide the switch cover back (1) and lift it straight up (2) until it disengages from the computer.
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5. Remove the two PM2.5x4.5 screws that secure the keyboard to the computer.

6. Slide the keyboard back (1), and rotate it forward (2) until it rests on the base enclosure.

7. Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the switch cover and keyboard.
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Memory module

Bf NOTE: Older models use DDR2 memory, while newer models use DDR3 memory. You cannot use
model numbers to determine the type of memory a model uses.

NOTE: When adding a second memory module, be sure it is the same type and speed as the
installed memory module. DDR2 memory modules cannot be mixed with DDR3 memory modules.

Description Spare part number

For use in models that use DDR2 memory:

2-GB (PC2-6400, 800-MHz, DDR2) 598858-001

1-GB (PC2-6400, 800-MHz, DDR2) 598861-001

For use in models that use DDR3 memory:

2-GB (PC3-10600, 1333-MHz, DDR3) 598856-001

1-GB (PC3-10600, 1333-MHz, DDR3) 598859-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 43)

Remove the memory module:
1. Position the computer with the front toward you.

2. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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3.  Remove the memory module (2) by pulling the module away from the slot at an angle.

B NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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Optical drive

Bf NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number
DVD+RW and CD-RW SuperMulti Double-Layer Combo Drive with LightScribe 535761-001
Blu-ray ROM with LightScribe DVD+RW SuperMulti DL Drive 535759-001
DVD-ROM Drive 535760-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 43)

Remove the optical drive:
1. Position the computer with the front toward you.
2. Remove the slotted PM2.5x4.5 screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the left to release the optical drive from the computer.

4. Remove the optical drive (3) from the computer.
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5. Ifitis necessary to replace the optical drive bracket, position the optical drive with the rear
toward you.

6. Remove the two Phillips PM2.0%3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7. Remove the optical drive bracket (2).

-##%——
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Reverse this procedure to reassemble and install an optical drive.
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Speakers

Description Spare part number

Speaker Kit 535795-001

Before removing the speakers, follow these steps:

1.

4,
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 42).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 43).

Remove the speakers:

1.

Disconnect the speaker cable (1) from the system board and remove the speaker cable from the
clips and routing channel.

Bf NOTE: The two speakers are connected with a single cable.

2,
3.

Remove the four PM2.5%3.0 screws (2) that secure the speakers to the computer.

Remove the speakers (3) from the computer.

Reverse this procedure to install the speakers.
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Palm rest

Description Spare part number

Palm rest (includes TouchPad) 535775-001

Before removing the palm rest, follow these steps:

1.

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 42)

Remove the switch cover and keyboard (see Switch cover and keyboard on page 43)

Remove the palm rest:

1.
2.

Remove the three Phillips PM2.0%3.0 broadhead screws (1) from the system board.

Slide the palm rest back (2), then lift and rotate the front edge until the palm rest rests on the
system board (3).
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3. Release the ZIF connector (1) to which the TouchPad cable is connected, and then disconnect
the TouchPad cable (2) from the system board.

4. Remove the palm rest.

Reverse this procedure to install the palm rest.
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Hard drive

Bf NOTE: All hard drive spare part kits include a hard drive bracket.

Description Spare part number
500-GB, 7200-rpm hard drive 634920-001
320-GB, 7200-rpm hard drive 603783-001
320-GB, 5400-rpm hard drive 622643-001
250-GB, 7200-rpm hard drive 538972-001
250-GB, 5400-rpm hard drive 535763-001
160-GB, 7200-rpm hard drive 577972-001
Hard Drive Hardware Kit 630891-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 43).

6. Remove the palm rest (see Palm rest on page 51).

Remove the hard drive:

1. Position the computer with the front toward you.

2. Loosen the two Phillips PM2.0x4.0 screws (1) that secure the hard drive to the computer.

3. Loosen the Phillips PM2.5%10.0 captive screw (2) that secures the hard drive to the computer.
4

Grasp the Mylar tab (3) on the hard drive and slide the hard drive to the right to disconnect it
from the system board.
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5. Remove the hard drive (4) from the hard drive bay.

6. Ifitis necessary to replace the hard drive bracket, remove the two Phillips PM3.0x4.0 hard drive
bracket screws (1) from each side of the hard drive.

7.  Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Bluetooth module

Bf NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 535757-001.

Description Spare part number
Bluetooth 2.0 module 398393-002
Bluetooth 2.1 module 537921-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 43)

b. Palm rest (see Palm rest on page 51)

c. Hard drive (see Hard drive on page 53)

Remove the Bluetooth module:
1. Disconnect the Bluetooth module cable (1) from the system board.
2. Remove the Bluetooth module cable (2) from the routing path.

3. Remove the Bluetooth module from the clip (3) that secures it to the base enclosure.
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Reverse this procedure to install the Bluetooth module.

WLAN module

Description Spare part number

Broadcom 4322 802.11a/b/g/n WLAN modules:

e  Broadcom 4322 802.11a/b/g/in WLAN module for use in Antigua and Barbuda, Barbados, 504664-001
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S.
Virgin Islands, and the United States

e Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, 504664-002
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin,
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin
Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central
African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the lvory
Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia,
Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the
Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa,
San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra
Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

Broadcom 802.11/b/g WLAN modules:

° Broadcom 4312 802.11/b/g WLAN module for use in Antigua and Barbuda, Barbados, 504593-003
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S.
Virgin Islands, and the United States
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Description Spare part number

Broadcom 4312 802.11/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra,  504593-004
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda,
Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei,
Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic,
Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic,
East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho,
Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia,
the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal,
the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway,
Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines,
Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino,
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea,
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and
Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates,
the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

Intel Wi-Fi Link 5100 802.11a/b/g WLAN modules:

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions 480985-001

Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in Russia and the Ukraine 482957-001

Atheros 9285G 802.11b/g/n WiFi Adapter WLAN modules:

Atheros 9285G 802.11b/g/n WiFi Adapter WLAN module for use in Antigua and Barbuda, 580101-001
Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago,
the U.S. Virgin Islands, and the United States

Atheros 9285G 802.11b/g/n WiFi Adapter WLAN module for use in Afghanistan, Albania, 580101-002
Algeria, Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia,
Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium,
Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the
British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros,
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equatorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-
Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay,
Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa,
South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe
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Description Spare part number

Intel Wi-Fi Link 1000, 802.11b/g/n WLAN modules:

e Intel Wi-Fi Link 1000, 802.11b/g/n WLAN module for use in Andorra, Antigua and Barbuda, 572520-001
Argentina, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Barbados, Belgium, Bolivia,
Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, China,
Colombia, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, the Dominican
Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French Guiana,
Guadeloupe, Guam, Georgia, Germany, Ghana, Greece, Guatemala, Haiti, Honduras, Hong
Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, ltaly, Ivory Coast, Jamaica, Japan,
Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg,
Malawi, Malaysia, Malta, Martinique, Mauritius, Mexico, Monaco, Montenegro, Morocco, the
Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Oman, Pakistan,
Panama, Paraguay, Peru, the Philippines, Poland, Portugal, Puerto Rico, Quatar, Romania,
San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, South
Korea, Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and
Tobago, Turkey, United Arab Emirates, the United Kingdom, the United States, Uruguay, the
U.S. Virgin Islands, Venezuela, and Vietnam

e Intel Wi-Fi Link 1000, 802.11b/g WLAN module for use in Russia and the Ukraine 585984-001

Broadcom 43224AGN 802.11a/b/g/n 2x2 WiFi Adapter WLAN modules:

e  Broadcom 43224AGN 802.11a/b/g/n 2x2 WiFi Adapter WLAN module for use in Antigua and  582564-001
Barbuda, Aruba, the Bahamas, Barbados, Belize, Canada, Guam, Guinea, Haiti, Jamaica,
the Nether Antilles, Puerto Rico, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, the United States, and the U.S. Virgin Islands

e  Broadcom 43224AGN 802.11a/b/g/n 2x2 WiFi Adapter WLAN module for use in Afghanistan, 582564-002
Albania, Algeria, Andorra, Angola, Argentina, Armenia, Australia, Austria, Azerbaijan,
Bahrain, Belarus, Belgium, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Cape Verde, Cayman Islands, the Central African Republic, Chad, Chile, the
People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus,
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equatorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland,
France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece,
Grenada, Guadeloupe, Guatemala, Guinea-Bissau, Guyana, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Italy, the lvory Coast, Japan, Jordan, Kazakhstan, Kenya,
Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein,
Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali,
Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco,
Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Netherlands,
New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova,
Romania, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 42).

5.  Remove the switch cover and keyboard (see Switch cover and keyboard on page 43)

6. Remove the palm rest (see Palm rest on page 51).

Remove the WLAN module:

/A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and then receive a warning message,
remove the module to restore computer functionality, and then contact technical support through Help
and Support.

1. Position the computer with the front toward you.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

EY NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal.
The white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

3.  Remove the two Phillips PM2.5%3.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

4. Remove the WLAN module (3) by sliding the module away from the slot at an angle.

Ef NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion into the
WLAN module slot.

Reverse this procedure to install the WLAN module.
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Display assembly

Bf NOTE: All display assembly spare part kits include 2 WLAN antenna transceivers and cables.

Description Spare part number
17.3-inch, HD+ BrightView display assembly with camera 535777-001
17.3-inch, HD+ BrightView display assembly 535779-001
17.3-inch, HD+ display assembly with camera 535778-001
17.3-inch, HD+ display assembly 535776-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the following components:

a. Switch cover (see Switch cover and keyboard on page 43)

b. Keyboard (see Switch cover and keyboard on page 43)

c. Speakers (see Speakers on page 50)

d. Palm rest (see Palm rest on page 51)

Remove the display cable:

1. Turn the computer right-side up, with the front toward you.

2. Open the computer as far as possible.

3. Disconnect the display panel cable (1) from the system board.
4

Disconnect the camera and microphone module cables (2) from the system board, and then
remove the cables from the routing path (3).
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5. Remove the wireless antenna cables (4) from the clips and routing channels built into the top
cover.

Remove the display assembly:

1. Remove the six Phillips PM2.5x4.5 screws (1) that secure the display assembly to the computer,
and then lift the display assembly straight up (2) and remove it.

/A CAUTION: Support the display assembly when removing the following screws. Failure to
support the display assembly can result in damage to the display assembly and other computer
components.
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2. Ifitis necessary to replace the display bezel or display hinges, remove the eight rubber screw
covers (1) and the eight Phillips PM2.5%4.5 screws (2) that secure the display bezel to the
display assembly. The rubber screw covers are available in the Rubber Kit, spare part number
535793-001.

?

3. Lift the top inside edge of the display bezel (1) to detach it from the display assembly.

4. Lift the left and right inside edges of the of display bezel (2) to carefully detach them from the
display assembly.

5.  Carefully lift the bottom inside edge of the display bezel (3) to detach it from the display
assembly.

Bf NOTE: Make note of the routing of the display cable and the wireless antenna cable.

6. Carefully remove the upper hinge cover clips from the lower hinge covers on the display
assembly.

/A CAUTION: The lower hinge covers can be damaged if care is not taken when removing the
upper hinge cover clips.

7. Remove the display bezel from the display assembly (4). The display bezel is available using
spare part numbers 535770-001 (for use only with models without a webcam) and 535769-001
(for use only with models with a webcam).
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8. Ifitis necessary to replace the display hinges, remove the four Phillips PM2.5%x5.0 screws (1)
that secure the display panel to the display enclosure.

9. Remove the display panel (2).

10. Remove the four Phillips PM2.0x3.0 screws (1) that secure each display hinge to the display
panel.

B NOTE: When removing or replacing the eight Phillips screws, be sure to remove or replace
them in the same sequence as the numbering found on the display hinges (1, 2, 3, 4).

11. Remove the display hinges (2). The left and right display hinges are available in the Bracket Kit,
spare part number 535772-001.

12. If it is necessary to replace the wireless antenna cables, lift the tape (1) that secures the cables
to the display enclosure. The wireless antenna cables are included in the Display Cable Kit,
spare part number 535771-001.

13. Remove the wireless antennas (2).
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14. Remove the wireless antenna cables (3) from the clips and routing channels built into the top
cover.

15. Ifitis necessary to replace the webcam, gently pull the webcam cables (1) from the clips and
routing channels (2) built into the top cover. Lift the webcam (3) to remove it. The webcam cable
is included in the Display Cable Kit, spare part number 535771-001.
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16. If it is necessary to replace the microphone, lift the microphone from the clip (1) and gently pull
the microphone cable from the routing channels (2). The microphone cable is included in the
Display Cable Kit, spare part number 535771-001

Reverse this procedure to reassemble and install the display assembly.
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Top cover

Description Spare part number

Top cover 535796-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).
5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 43)

b. Memory module (see Memory module on page 46)

c. Optical drive (see Optical drive on page 48)

d. Speakers (see Speakers on page 50)

e. Palm rest (see Palm rest on page 51)

f.  WLAN module (see WLAN module on page 56)

g. Hard drive (see Hard drive on page 53)

h. Display assembly (see Display assembly on page 60)

Remove the top cover:

1. Turn the computer right-side up, with the front toward you.
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2. Release the ZIF connector (1) to which the power button cable is connected, and then
disconnect the cable from the system board (2).

3.  Remove the 22 top cover Torx T8M2.5%6.0 screws.

4. Lift the front edge of the top cover from beneath the audio jacks (1) until it disengages from the
base enclosure. Then lift the top cover (2) from the base enclosure.

Reverse this procedure to install the top cover.
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Power button board

Description Spare part number

Power button board (includes cable) 574493-001

Before removing the power button board, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 42).

Remove the following components:

a.

b.

g.

Switch cover and keyboard (see Switch cover and keyboard on page 43)

Optical drive (see Optical drive on page 48)

Speakers (see Speakers on page 50)

Palm rest (see Palm rest on page 51)

Hard drive (see Hard drive on page 53)

Display assembly (see Display assembly on page 60).

Top cover (see Top cover on page 66)

Remove the power button board:

1.
2,

Position the top cover upside-down with the rear toward you.

Lift the power button board straight up and off the top cover.
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Reverse this procedure to install the power button board.

Modem module

Description Spare part number
For use in all countries and regions except Australia and New Zealand 510100-001
For use only in Australia and New Zealand 510100-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).
5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 43)

b. Memory module (see Memory module on page 46)

c. Optical drive (see Optical drive on page 48)

d. Speakers (see Speakers on page 50)

e. Palm rest (see Palm rest on page 51)

f.  WLAN module (see WLAN module on page 56)

g. Hard drive (see Hard drive on page 53)

h. Display assembly (see Display assembly on page 60)

i. Top cover (see Top cover on page 66)

Remove the modem module:

1. Remove the two Phillips PM2.5x3.0 screws (1) that secure the modem module to the system
board.

2. Lift the rear edge of the modem module (2) to release it from the system board.
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3. Lift the tape (3) to disconnect the modem module cable (4).

4. Remove the modem module.

Reverse this procedure to install the modem module.

70 Chapter 4 Removal and replacement procedures



USB connector module

Description Spare part number

Cable Kit 535757-001

Before removing the USB connector module, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 42).
Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 43)

b. Memory module (see Memory module on page 46)

c. Optical drive (see Optical drive on page 48)

d. Speakers (see Speakers on page 50)

e. Palmrest (see Palm rest on page 51)

f.  WLAN module (see WLAN module on page 56)

g. Hard drive (see Hard drive on page 53)

h. Display assembly (see Display assembly on page 60)

i. Top Cover (see Top cover on page 66)

Remove the USB connector module:

1.
2.

Disconnect the USB cable from the system board (1).
Lift up the USB cable from the routing channels in the base enclosure (2).

Remove the short Phillips PM2.5%x3.0 screw (3) and the long Phillips PM2.5%9.0 screw (4) that
secure the USB connector module to the base enclosure.
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4. Remove the USB connector module (5).

Reverse this procedure to install the USB connector module.
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RTC battery

Description Spare part number

RTC battery 449137-001

Before removing the RTC battery, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 42).

Remove the following components:

a.

b.

h.

Switch cover and keyboard (see Switch cover and keyboard on page 43)

Memory module (see Memory module on page 46)

Optical drive (see Optical drive on page 48)

Speakers (see Speakers on page 50)

Palm rest (see Palm rest on page 51)

WLAN module (see WLAN module on page 56)

Hard drive (see Hard drive on page 53)

Display assembly (see Display assembly on page 60)

Top cover (see Top cover on page 66)

Remove the RTC battery:

1.

Position the base enclosure, with the front toward you.
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2. Remove the RTC battery from the socket on the system board.

Reverse this procedure to install the RTC battery.
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Heat sink and fan

Bf NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number
Heat sink 535767-001
Fan 535766-001001

Before removing the heat sink and fan, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5.  Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 43)

b. Memory module (see Memory module on page 46)

c. Optical drive (see Optical drive on page 48)

d. Speakers (see Speakers on page 50)

e. Palmrest (see Palm rest on page 51)

f.  WLAN module (see WLAN module on page 56)

g. Hard drive (see Hard drive on page 53)

h. Display assembly (see Display assembly on page 60)

i. Top cover (see Top cover on page 66)

Remove the heat sink and fan:

1. Following the 1 through 7 sequence stamped into the heat sink and fan, loosen the seven
Phillips captive screws (1).

2. Disconnect the fan cable (2) from the system board.
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3. Lift the heat sink and fan from the system board (3).

4. Toremove the fan, turn the heat sink upside down and remove the three Phillips PM2.0x3.0
screws (1) that secure the fan to the heat sink.

ﬁ\
x | T
| | |
|
|
|1 |
|

5. Remove the fan (2).

o
el

Reverse this procedure to install the fan.

Bf NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is
displaced through the ventilation grill located on the left side of the computer.
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B NOTE: The thermal material must be thoroughly cleaned from the surfaces of the system board (1),
(2), and (3) and the heat sink components (4), (5), and (6) and must be replaced each time the heat
sink is removed. Replacement thermal material is included with all heat sink, system board, cable,
and processor spare part kits.

RJ-45 (network) jack

B NOTE: The Cable Kit includes replacement thermal material.

Description

Spare part number

Cable Kit

535757-001

Before removing the RJ-45 (network) jack, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 42).

Remove the following components:

a.

b.

Switch cover and keyboard (see Switch cover and keyboard on page 43)

Memory module (see Memory module on page 46)

Optical drive (see Optical drive on page 48)

Speakers (see Speakers on page 50)

Palm rest (see Palm rest on page 51)

WLAN module (see WLAN module on page 56)

Hard drive (see Hard drive on page 53)
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h. Display assembly (see Display assembly on page 60)

i. Top Cover (see Top cover on page 66)

j-  Heat sink and fan (see Heat sink and fan on page 75)

Remove the RJ-45 (network) jack:

1. Disconnect the RJ-45 (network) cable from the system board (1) and remove the tape (2) that
secures the cable to the base enclosure.

2. Lift the RJ-45 (network) jack (3) straight up from the retention clips to remove it.

Reverse this procedure to install the RJ-45 (network) jack.
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Processor

Bf NOTE: All processor spare part kits include replacement thermal material.

Description Spare part number

Intel Core2 Duo processors:

T5870 (2.0 GHz, 800-MHz FSB, 2-MB L2 cache) 535835-001

T6570 (2.1 GHz, 800-MHz FSB, 2-MB L2 cache, TJ 100) (not available for Japan. Only available =~ 513598-001
with Intel WLAN or no WLAN)

T6670 (2.2 GHz, 800-MHz FSB, 2-MB L2 cache) 572927-001
P7370 (2.0 GHz, 1066-MHz FSB, 3-MB L2 cache) (Only available with Intel WLAN) 507966-001
P7570 (2.26 GHz, 1066-MHz FSB, 3-MB L2 cache) 572930-001
P8600 (2.4 GHz, 1066-MHz FSB, 3-MB L2 cache) 507961-001
P8700 (2.53 GHz, 1066-MHz FSB, 3-MB L2 cache) 507960-001
T9400 (2.53 GHz, 1066-MHz FSB, 6-MB L2 cache, 35W) 507954-001
T9600 (2.8 GHz, 1066-MHz FSB, 6-MB L2 cache) 507952-001

Intel Pentium Dual-Core processors:

T4200 (2.0 GHz, 800-MHz FSB, 1-MB L2 cache) 513599-001
T4300 (2.16 GHz, 800-MHz FSB, 1-MB L2 cache) 572929-001
T4400 (2.20 GHz, 800-MHz FSB, 1MB L2 cache) 584296-001

Intel Celeron processors:

Intel Celeron 585 (2.16 GHz, 800-MHz FSB, 2-MB L2 cache) 519898-001

Intel Celeron 900 (2.20 GHz, 800-MHz FSB, 1-MB L2 cache) 534419-001

Intel Celeron Dual-Core processors:

T1600 (1.66 GHz, 667-MHz FSB, 1-MB L2 cache) 532324-001
T1700 (1.83-GHz, 667-MHz FSB, 1-MB L2 cache) 534084-001
T3000 (1.8-GHz, 800-MHz FSB, 1-MB L2 cache) 572926-001
T3100 (1.9-GHz, 800-MHz FSB, 1-MB L2 cache) 572925-001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 42).

5. Remove the following components:

a.

b.

j-

Switch cover and keyboard (see Switch cover and keyboard on page 43)

Memory module (see Memory module on page 46)

Optical drive (see Optical drive on page 48)

Speakers (see Speakers on page 50)

Palm rest (see Palm rest on page 51)

Hard drive (see Hard drive on page 53)

WLAN module (see WLAN module on page 56)

Display assembly (see Display assembly on page 60)

Top cover (see Top cover on page 66)

Heat sink and fan (see Heat sink and fan on page 75)

Remove the processor:

1. Position the base enclosure, with the front toward you.

2. Use aflat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.

3.  Lift the processor (2) straight up and remove it.

B NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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System board

Bf NOTE: All system board spare part kits include the ExpressCard assembly.

NOTE: All system board spare part kits include replacement thermal material.

Description Spare part number

System board for use in computers with DDR2 memory (includes replacement thermal material 574508-001
and the ExpressCard assembly)

System board for use in computers with DDR3 memory (includes replacement thermal material 583077-001
and the ExpressCard assembly)

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 42).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 43)

b. Memory module (see Memory module on page 46)

c. Optical drive (see Optical drive on page 48)

d. Speakers (see Speakers on page 50)

e. Palmrest (see Palm rest on page 51)

f. Hard drive (see Hard drive on page 53)

g. Display assembly (see Display assembly on page 60)

h. Top cover (see Top cover on page 66)

When replacing the system board, be sure that the following components are removed or
disconnected from the defective system board and installed on the replacement system board:

e  USB connector module cable (see USB connector module on page 71)

e  Bluetooth module cable (see Bluetooth module on page 55)

e WLAN module cable (see WLAN module on page 56)

e RTC battery (see RTC battery on page 73)

e Heat sink and fan (see Heat sink and fan on page 75)
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e RJ-45 (network) cable (see RJ-45 (network) jack on page 77)

e Processor (see Processor on page 79)

Remove the system board:
1. Position the base enclosure, with the front toward you.

2. Lift the power connector (1) from the retention clips in the base enclosure and remove the power
cable (2) from the routing clips.

3.  Remove the battery connector board (1).

4. Remove the two Phillips PM2.5x3.0 screws (2) that secure the optical drive connector board to
the base enclosure.

5.  Remove the Phillips PM2.5%3.0 screw (3) that secures the system board to the base enclosure.
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6. Lift the right side of the system board at an angle (1) and remove the optical drive board (2).

O
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7. Flex the left side of the base enclosure (1) until the external monitor connector and the HDMI
connector are clear of the openings in the base enclosure.

8. Lift the right side of the system board at an angle (2) and remove it (3) from the base enclosure.

9. Turn the system board upside down with the rear panel toward you to disconnect the power
cable.

Reverse this procedure to install the system board.
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5 Computer Setup

Computer Setup in Windows Vista and Windows XP
Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

Ef NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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Bf NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.
3. Select the File, Security, Diagnostics, or System Configuration menu.
To exit Computer Setup menus, choose one of the following methods:

e To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.

e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

B NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

Press 10 to enter BIOS Setup.
Use a pointing device or the arrow keys to select File > Restore defaults.

Follow the on-screen instructions.

o » 0 N

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

Bf NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.
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B NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by

your computer.

File Menu

Select

To do this

System Information

e View identification information for the computer and the
batteries in the system.

e View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time

Set or change the date and time on the computer.

Restore defaults

Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Ignore changes and exit

Cancel any changes entered during the current session.
Then exit and restart the computer.

Save changes and exit

Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.

Security menu

Ef NOTE: Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Setup BIOS Administrator Password

Set up a BIOS administrator password.

User Management (requires a BIOS administrator
password)

e Create a new BIOS user account.

° View a list of ProtectTools users.

Password Policy (requires an administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (disabled by default).

Always Prompt for HP SpareKey Enroliment

Enable/disable HP SpareKey enroliment (disabled by
default).

Allow Reset of HP ProtectTools security keys

Enable/disable reset of HP ProtectTools security keys.

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

DriveLock Passwords

e Enable/disable DriveLock on any computer hard drive
(enabled by default).

e Change a DrivelLock user password or master
password.

NOTE: DrivelLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.
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Select To do this

Automatic DriveLock Enable/disable Automatic DriveLock support.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.

Diagnostics menu

Select To do this

System Diagnostics Menu e  System Information—Displays the following information:

° Identification information for the computer and the
batteries in the system.

° Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

e  Start-up Test—Verifies the system components needed
for starting the computer.

e  Run-In Test—Runs a comprehensive check on system
memory.

° Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.

e  Error Log—Displays a log file if any errors have
occurred.

System Configuration menu

Bf NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.
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Select

To do this

Boot Options

Set a Startup Menu delay (in seconds).
Enable/disable Custom Logo (disabled by default).

Enable/disable Display Diagnostic URL (enabled by
default).

Enable/disable CD-ROM boot (enabled by default).
Enable/disable SD Card boot (enabled by default).
Enable/disable floppy boot (enabled by default).

Enable/disable PXE Internal NIC boot (disabled by
default).

Set the Express Boot Popup delay in seconds.

Set the boot order.

Device Configurations

Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

° Use of a USB keyboard in Computer Setup even
when a Windows® operating system is not
running.

° Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

Enable/disable fan always on while connected to an AC
outlet (disabled by default).

Enable/disable Data Execution Prevention (select
models only; disabled by default). When enabled, the
processor can disable some virus code execution,
which helps to improve computer security.

SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:

° AHCI (Advanced Host Controller Interface)
0 IDE (Integrated Drive Electronics)

NOTE: Availability of the options above varies by
computer model.

Enable/disable HP QuickLook 2 (enabled by default).

Enable/disable Virtualization Technology (select models
only; disabled by default).

Enable/disable Dual-Core CPU (enabled by default).

Enable/Disable Unified Extensible Firmware Interface
(UEFI) mode (enabled by default).
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Select

To do this

Built-In Device Options

Enable/disable the wireless button state (enabled by
default).

Enable/disable embedded WWAN device radio
(enabled by default).

Enable/disable embedded Bluetooth device radio
(enabled by default).

Enable/disable the Network Interface Controller (LAN)
(enabled by default).

Set the wake on LAN state. Options include the
following:

° Disabled
° Boot to Network (set by default)
° Follow Boot Order

Enable/disable the optical disk drive (enabled by
default).

Enable/disable the microphone.
Enable/disable a modem device (enabled by default).

Enable/disable the embedded WLAN device (enabled
by default).

Enable/disable LAN/WLAN switching (disabled by
default).

Enable/disable the integrated camera (select models
only; enabled by default).

Port Options (all are enabled by default)

NOTE: All port options are enabled by default.

Enable/disable the ExpressCard slot.
Enable/disable the flash media reader.
Enable/disable the USB port.

CAUTION: Disabling the USB port also disables

MultiBay devices and ExpressCard devices on the
advanced port replicator.

Set Security Level

Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults

Restore the default security settings.
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Computer Setup in Linux

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.

Bf NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to
navigate and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB
legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer.

2. Before your operating system opens and while the “F10=ROM Based Setup” message is
displayed in the lower-left corner of the screen, press f10.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen. Because
Computer Setup is not operating system based, it does not support the TouchPad. Navigation
and selection are by keystroke:

To choose a menu or a menu item, use the arrow keys.

To select an item, press enter.

To close open dialog boxes and return to the main Computer Setup screen, press esc.
To view navigation information, press f1.

To change the language, press 2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

To exit Computer Setup without saving your preferences, use the arrow keys to select File
> Ignore Changes And Exit. Then follow the instructions on the screen.

To save your preferences and exit Computer Setup, use the arrow keys to select File >
Save Changes And Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.
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Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore Defaults, and then press enter.
3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes And Exit. Then follow the instructions on the screen.

Bf NOTE: Your password settings and security settings are not changed when you restore the factory
settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

Bf NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu

Select To do this

System information e View identification information for the computer.

e View specification information for the processor, cache
and memory size, and system ROM.

Restore Defaults Replace the configuration settings in Computer Setup with
the original factory settings. (Password settings and security
settings are not changed when you restore the factory
settings.)

Ignore Changes And Exit Cancel any changes entered during the current session.
Then exit and restart the computer.

Save Changes And Exit Save any changes entered during the current session. Then

exit and restart the computer. Your changes go into effect
when the computer restarts.

Security menu

Select To do this

Setup Password Enter, change, or delete a setup password.
Power-On Password Enter, change, or delete a power-on password.
Password Options e Enable/disable stringent security.

e Enable/disable stringent security.
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DriveLock Passwords e Enable/disable DriveLock on any computer hard drive.

e Enter, change, or disable DriveLock on an optional
MultiBay hard drive.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

System IDs Enter a user-defined computer asset tracking number and
ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary
hard drive. The following options are available:

e Fast: Runs the Disk Sanitizer erase cycle once.
e  Fast: Runs the Disk Sanitizer erase cycle once.

e  Custom: Allows you to select the desired number of
Disk Sanitizer erase cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the
primary hard drive is destroyed permanently.

Diagnostics menu

Select To do this
HDD Self-Test Option Memory Check
Memory Check Run a comprehensive check on system memory.

System Configuration menu

B NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language Change the Computer Setup language.
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Boot options

Set an 9, 10, and f12 delay when starting up.
Enable/disable CD-ROM boot.

Enable/disable floppy boot.

Enable/disable internal network adapter boot.

Enable/disable MultiBoot, which sets a boot order that
can include most boot devices in the system.

Set the Express Boot Popup delay in seconds.
Set the boot order.

° 1st boot device: USB CD-ROM

° 2nd boot device: USB floppy

° 3rd boot device: USB SuperDisk

o 4th boot device: Notebook hard drive

° 5th boot device: USB hard disk

° 6th boot device: Network controller

Device Configurations

Swap the functions of the fn key and left ctrl key.

Enable/disable USB legacy support. When enabled,
USB legacy support allows the following:

° Use of a USB keyboard in Computer Setup even
when a your operating system is not running.

° Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

Enable/disable BIOS DMA data transfers.

Enable/disable fan always on while connected to an AC
outlet.

Enable/disable data execution prevention.
Enable/disable LAN power saving mode.
Enable/disable SATA Native Mode.
Enable/disable Dual-Core CPU.

Enable/disable HDD translation mode.

Computer Setup in Linux
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Built-in device options

Enable/disable embedded WLAN Device Radio.
Enable/disable embedded Bluetooth Device Radio.
Enable/disable Network Interface Controller (NIC)
Enable/disable LAN/WLAN Switching.
Enable/disable Wake on LAN.

Enable/disable the integrated camera (webcam)

Port options

Enable/disable USB port.

Enable/disable ExpressCard slot.
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6 Specifications

Computer specifications

Metric U.s.
Dimensions
Depth 27.0cm 10.6 in
Width 41.06 cm 16.17 in
Height (front to rear) 3.20 to 3.68 cm 1.23t01.45in
Weight (equipped with optical drive, hard drive, and battery) 3.08 kg 6.8 Ibs
Input power
Operating voltage 18.5Vdc @ 4.74 A-90 W
Operating current 474 A
Temperature
Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F
Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F
Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft
Nonoperating -15mto 12,192 m -50 ft to 40,000 ft
Shock

Operating 125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration

Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate

Computer specifications
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Metric u.s.

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.

17.3-inch, HD+ display specifications

Metric U.s.
Dimensions
Height 38.21 cm 15.0in
Width 20.83 cm 8.2in
Diagonal 43.94 cm 17.3in
Active area 38.21 x 21.49 cm 15.04 x 8.46 in
Weight (maximum) 570 g 1.26 Ibs
Number of colors Up to 16.8 million
Contrast ratio 500:1 (min)-BV, 300:1 (min)-AG
Brightness 200 nits (typical)
Pixel resolution
LCD mode N
Format 1600 x 900
Active area HD+
Backlight LED
Total power consumption 53W
Viewing angle SVA
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Hard drive specifications

500-GB 320-GB* 250-GB* 160-GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm
Weight 101 g 101g 10149 101g
Interface type SATA SATA SATA SATA
Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 3ms 3ms 3ms 3ms
Average 13 ms 13 ms 13 ms 13 ms
Maximum 24 ms 24 ms 24 ms 24 ms
Logical blocks 976,754,000 625,122,560 488,376,120 312,560,640
Disc rotational speed 5400 rpm 5400 rpm 5400 rpm 5400 rpm
Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.

Hard drive specifications
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DVD*RW and CD-RW SuperMulti Double-Layer Combo
Drive with LightScribe specifications

Applicable disc

Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-
ROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-
ROM (DVD-5, bVD-9, DVD-10, DVD-18), DVD-
R, DVD-RW, DVD+R, DVD+RW. DVD-RAM

Write:

CD-R, CD-RW, DVD+R, DVD
+RW, DVD-R, DVD-RW, DVD-
RAM, LightScribe

Access time CD DVD
Random <150 ms <160 ms
Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
8x-DVD+RW 10.800 KB/sec
8X DVD-R 10,800 KB/sec
6X DVD-RW 8,100 KB/sec
5X DVD-RAM 6,750 KB/sec

4X-DVD+R Dual Layer

5,400 KB/sec

4X-DVD-R Dual Layer

5,400 KB/sec

Transfer mode

Multiword DMA Mode
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Blu-ray ROM with LightScribe DVD*RW SuperMulti DL
Drive specifications

Applicable disc

Read: Write:

CD-DA, CD+(E)G, CD-MIDI, CD- CD-R, CD-RW, DVD+R, DVD+R(9), DVD+RW, DVD-R,
TEXT, CD-ROM, CD-ROM XA, DVD-R(9), DVD-RW, DVD-RAM, LightScribe

MIXED MODE CD, CD-I, CD-I
Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-
EXTRA, Portfolio, CD-R, CD-
RW), CD-R, CD-RW, DVD-ROM
(DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD
+R, DVD+RW. DVD-RAM, BD-
ROM, BD-R, BD-RE

Access time CcDh DVD Blu-ray
Random <110 ms <130 ms 230 ms
Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD 10,800 KB/sec
4X BD 1,800 KB/sec
16X CD-R 1,200 KB/sec
16X CD-RW 1,500 KB/sec
8X DVD+R 10,800 KB/sec
8X DVD+RW 10,800 KB/sec
8X DVD-R 10,800 KB/sec
8X DVD-RW 8,100 KB/sec

4X DVD+R Dual Layer

5,400 KB/sec

4X DVD-R Dual Layer

5,400 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA mode 2

Blu-ray ROM with LightScribe DVD+RW SuperMulti DL Drive specifications
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DVD-ROM Drive

Applicable disc

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD, Video CD), Multisession CD (Photo-CD, CD-
EXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

Access time CcD DVD
Random <110 ms <110 ms
Cache buffer 512 KB

Data transfer rate

CD-ROM (24X)

3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X)

10,800 KB/s (1,352 KB/s at 1X DVD
rate)

Multiword DMA mode 2

16.6 MB/s

System DMA specifications

Hardware DMA

System function

DMAO Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller
DMA5* Available for ExpressCard
DMAG6 Not assigned

DMA7 Not assigned

*ExpressCard controller can use DMA 1, 2, or 5.
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System interrupt specifications

Hardware IRQ System function

IRQO System timer

IRQ1 Standard 101-/102-Key or Microsoft Natural P/S2 Keyboard with HP QLB
IRQ2 Mobile Intel® 4 Series Chipset PCI Express Root Port-2A41
IRQ3 Intel® ICH9 Family PCI Express Root Port1-2940

IRQ4 Intel® ICH9 Family PCI Express Root Port2-2942

IRQ5 Intel® ICH9 Family PCI Express Root Port3-2944

IRQ6 Intel® ICH9 Family PCI Express Root Port5-2948

IRQ7 Intel® ICH9 Family PCI Express Root Port6-294A

IRQ8 ATI Mobility Radeon HD 4330

IRQ9 Intel® WiFi Link 5100 ABG

IRQ12 Synaptics PS/2 Port TouchPad

IRQ13 Numeric data processor

IRQ16 Intel® ICH9 Family USB Universal Host Controller-2937
IRQ-17 High Definition Audio Controller

IRQ-18 Intel® ICH9 Family USB Universal Host Controller-2939
IRQ-19 Intel® ICH9 Family USB Universal Host Controller-293C
IRQ-20 Intel® ICH9 Family USB Universal Host Controller-293A
IRQ-21 Intel® ICHOM-E/M SATA AHCI Controller

IRQ-22 Intel® ICH9 Family USB Universal Host Controller-2935

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: ExpressCards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the
serial port may assert IRQ3 or IRQ4.
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System I/O address specifications

1/0 address (hex)

System function (shipping configuration)

000-01F Direct memory access controller

000-CF7 PCI Bus

020-021 Programmable interrupt controller

024-025 Programmable interrupt controller

028-029 Programmable interrupt controller

02C-02D Programmable interrupt controller

02E-02F Motherboard resources

030-031 Programmable interrupt controller

034-035 Programmable interrupt controller

038-039 Programmable interrupt controller

03C-03D Programmable interrupt controller

040-043 System timer

04E-04F Motherboard resources

050-053 System timer

060-060 Standard 101-/102-Key or Microsoft Natural P/S2 Keyboard with HP QLB
061-061 Motherboard resources

062-062 Microsoft ACPI-Compliant Embedded Controller
063-063 Motherboard resources

064-064 Standard 101-/102-Key or Microsoft Natural P/S2 Keyboard with HP QLB
065-065 Motherboard resources

066-066 Microsoft ACPI-Compliant Embedded Controller
067-067 Motherboard resources

070-070 Motherboard resources

070-077 System CMOS/real time clock

080-080 Motherboard resources

081-091 Direct memory access controller

092-092 Motherboard resources

093-09F Direct memory access controller

0AO0-0A1 Programmable interrupt controller

0A4-0A5 Programmable interrupt controller

0A8-0A9 Programmable interrupt controller

0AC-0AD Programmable interrupt controller

0B0-0B1 Programmable interrupt controller
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1/0 address (hex)

System function (shipping configuration)

0CO0-0DF Direct memory access controller

OF0-0F0 Numeric data processor

200-27F Motherboard resources

3B0-3BB ATI Mobility Radeon HD 4330

3B0-3BB Mobile Intel® 4 Series Chipset PCI Express Root Port-2A41
3C0-3DF ATI Mobility Radeon HD 4330

3C0-3DF Mobile Intel® 4 Series Chipset PCI Express Root Port-2A41
400-47F Motherboard resources

4D0-4D1 Programmable interrupt controller

500-57F Motherboard resources

0D00-FFFF PCI bus

1000-1003 Motherboard resources

1010-101F Motherboard resources

2000-20FF Marvelll Yukon 88E88072 PCI-E Gigabit Ethernet Controller
2000-20FF Intel® ICH9 Family PCI Express Root Port6-294A
3000-4FFF Intel® ICH9 Family PCI Express Root Port5-2948
5000-6FFF Intel® ICH9 Family PCI Express Root Port3-2944
7000-70FF ATI Mobility Radeon HD 4330

7000-70FF Mobile Intel® 4 Series Chipset PCI Express Root Port-2A41
8000-801F Intel® ICHOM-E/M SATA AHCI Controller

8020-803F Intel® ICH9 Family USB Universal Host Controller-2936
8040-805F Intel® ICH9 Family USB Universal Host Controller-2935
8060-807F Intel® ICH9 Family USB Universal Host Controller-2934
8080-809F Intel® ICH9 Family USB Universal Host Controller-2939
80A0-80BF Intel® ICH9 Family USB Universal Host Controller-2938
80C0-80DF Intel® ICH9 Family USB Universal Host Controller-2937
CF8-CFB

80E0-80E7 Intel® ICHOM-E/M SATA AHCI Controller

80E8-80EF Intel® ICHOM-E/M SATA AHCI Controller

80F0-80F3 Intel® ICHOM-E/M SATA AHCI Controller

80F4-80F7 Intel® ICHOM-E/M SATA AHCI Controller

EF80-EF9F Motherboard resources

FEOO-FEOF Motherboard resources

System I/O address specifications
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1/0 address (hex)

System function (shipping configuration)

FE80-FE8F

Motherboard resources

FFFF—FFFF

Motherboard resources

System memory map specifications

Memory address

System function

000A0000-000BFFFF

ATI Mobility Radeon HD 4330

000A0000-000BFFFF

Mobile Intel® 4 Series Chipset PCI Express Root Port-2A41

000A0000-000BFFFF

PCl bus

C0000000-CFFFFFFF

ATI Mobility Radeon HD 4330

C0000000-CFFFFFFF

Mobile Intel® 4 Series Chipset PCI Express Root Port-2A41

C0000000-DFFFFFFFF

PCl bus

D0000000-DOOFFFFF

Intel® 82801 PCI Bridge-2448

D0100000-DO103FFF

Marvelll Yukon 88E88072 PCI-E Gigabit Ethernet Controller

D0100000-DO1FFFFF

Intel® ICH9 Family PCI Express Root Port6-294A

D0200000-D41FFFFF

Intel® ICH9 Family PCI Express Root Port5-2948

D4200000-D81FFFFF

Intel® ICH9 Family PCI Express Root Port3-2944

104 Chapter 6 Specifications



7 Screw listing

This chapter provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part number
535794-001.

Phillips PM2.0%3.0 screw

=® [p

mm o todiotnnl

Color Quantity Length Thread Head diameter

Silver 21 3.0 mm 2.0 mm 5.0 mm
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Where used: 2 screws that secure the optical drive bracket to the optical drive
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Where used: 3 screws that secure the system board to the base enclosure
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Where used: 8 screws that secure the display hinges to the display panel
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Where used: 3 screws that secure the fan to the heat sink

Where used: 3 screws that secure the system board to the base enclosure.
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Where used: 2 screws that secure the top cover and battery connector board to the base enclosure
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Phillips PM2.5%4.5 screw

®  [fm

mm oo

Color Quantity Length Thread Head diameter

LTI

Black 21 4.5 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the display panel to the display assembly

Where used: 2 screws that secure the keyboard to the computer
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Where used: 8 screws that secure the display bezel to the display enclosure

Where used: 1 screw that secures the optical drive to the computer

Where used: 6 screws that secure the display assembly to the computer.
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Phillips PM3.0%4.0 screw

-® [m

mm Lot

Color Quantity Length Thread Head diameter

Silver 4 4.0 mm 3.0 mm 5.0 mm

Where used: 4 screws that secure the hard drive bracket to the hard drive
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Phillips PM2.5%3.0 screw

® [o

mm Lot

Color Quantity Length Thread Head diameter

Black 11 3.0 mm 2.5 mm 5.0 mm

Where used: 2 screws that secure the WLAN module to the system board

Where used: 2 screws that secure the switch cover to the computer
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Where used: 2 screws that secure the modem module to the computer

Where used: 4 screws that secure the speaker assembly to the computer
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Where used: 1 screw that secures the USB board to the computer
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Phillips PM2.0%2.0 broadhead screw

A
Color Quantity Length Thread Head diameter
Black 2 2.0 mm 2.0 mm 6.0 mm

Where used: 2 screws that secure the button board to the switch cover
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Phillips PM2.0%3.0 broadhead screw

mm
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Color Quantity Length Thread Head diameter

Black 6 3.0 mm 2.0 mm 6.0 mm

Where used: 3 screws that secure the switch cover to the base enclosure

Where used: 3 screws that secure the palm rest to the computer
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Phillips PM2.0x4.0 screw

SO

mm Lot

Color Quantity Length Thread Head diameter

Silver 2 4.0 mm 2.0 mm 4.5 mm

Where used: 2 silver screws that secure the hard drive to the top cover
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Phillips PM2.5%9.0 screw

m
Color Quantity Length Thread Head diameter
Black 1 9.0 mm 2.5mm 5.0 mm

Where used: One screw that secures the USB board to the system board
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Phillips PM2.5%10.0 captive screw

=®  fromm
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Color Quantity Length Thread Head diameter

Silver 6 10.0 mm 2.5mm 5.0 mm

Where used: 5 captive screws that secure the heat sink to the system board
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Where used: One captive screw that secures the hard drive to the computer (screw is secured to the
hard drive bracket)

120 Chapter 7 Screw listing



Phillips PM2.5%8.0 captive screw

=@ [pum

mm Lot

Color Quantity Length Thread Head diameter

Black 2 8.0 mm 2.5 mm 5.0 mm

Where used: 2 captive screws that secure the heat sink to the computer
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Torx T8M2.5%6.0 screw

=@® [jom

mm Lot

Color Quantity Length Thread Head diameter

Black 25 6.0 mm 2.5 mm 5.0 mm

Where used: 22 screws that secure the top cover to the base enclosure.

122 Chapter 7 Screw listing



Where used: 3 screws that secure the system board to the base enclosure.
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8 Backup and recovery

Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:
e  Backing up individual files and folders

e Backing up the entire hard drive (select models only)

e  Scheduling automatic backups (select models only)

e Creating system restore points

e Recovering individual files

e Restoring the computer to a previous state

e Recovering information using recovery tools

B NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents folder, and back it up regularly.

e Back up templates that are stored in their associated programs.

e Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

e  When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend
on the type of optical drive installed in your computer.

Bf NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e  When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center , follow these steps:

B NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your
files.

149,

B NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

e 11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

Bf NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.
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Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your
files.

Bf NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.

To recover your information using Startup Repair, follow these steps:

/A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To
find the partitions, select Start > Computer.

Bf NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.
4. Select Repair your computer.

5. Follow the on-screen instructions.

B NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11

/A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The 11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.

Bf NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section in this guide.
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3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4. Press 11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most
recent backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow the
on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

/A CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

Bf NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.
4. Follow the on-screen instructions.
5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery in Windows XP

Overview

To protect your information, use the Windows Backup utility (select models only) to back up files
and folders or create recovery points. In case of system failure, you can use the backup files to
restore your computer.

Windows provides the following options:

e  Backing up individual files and folders
e Backing up all files and folders

e  Scheduling automatic backups

e Creating recovery points

e Recovering information

= NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.
Note the following when backing up:

e  Store personal files in the My Documents folder, and back it up periodically.

e Back up templates stored in their associated programs.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:
a. Display the screen you want to save.
b. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.
c. Open a word-processing document, click Edit > Paste.
The screen image is added to the document.
d. Save the document.

To create a backup using the Windows Backup utility , follow these steps:
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B NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1.
2.

Click Start > All Programs > Accessories > System Tools > Backup.

Follow the on-screen instructions.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

Windows recovery tools (select models only): You can use the Windows Backup utility to
recover information you have previously backed up.

Operating System and Driver Recovery discs (included with your computer): You can
use the discs to recover your operating system and programs installed at the factory.

Recovering your information

To recover information you previously backed up, follow these steps:

1.
2,

3.
4,

If possible, back up all personal files.

Click Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard opens.

Click Restore files and settings, and then click Next.

Follow the on-screen instructions.

B NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs

/A CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files.

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.

Backup and recovery in Windows XP 129



9 Connector pin assignments

Audio-in (microphone)

Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground

Audio-out (headphone)

Pin Signal

1 Audio out, left channel
2 Audio out, right channel
3 Ground
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External monitor

@O O00®
®000 W
©O000®G

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock
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HDMI

Pin Signal

1 Transition minimized differential signal (TDMS) data 2+

2 Transition minimized differential signal (TDMS) data 2 shield
3 Transition minimized differential signal (TDMS) data 2-

4 Transition minimized differential signal (TDMS) data 1+

5 Transition minimized differential signal (TDMS) data 1 shield
6 Transition minimized differential signal (TDMS) data 1 shield
7 Transition minimized differential signal (TDMS) data 0+

8 Transition minimized differential signal (TDMS) data 0 shield
9 Transition minimized differential signal (TDMS) data 0-

10 Transition minimized differential signal (TDMS) Clock +

11 Transition minimized differential signal (TDMS) data clock shield
12 Transition minimized differential signal (TDMS) data clock-
13 Consumer electronics control (CEC)

14 No connect

15 Display data channel (DDC) clock

16 Display data channel (DDC) data

17 Ground

18 +5V Power

19 Hot plug detect
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RJ-11 (modem)

123456

Pin

Signal

Unused

Tip

Ring

Unused

o ||~ W |DN | =

Unused

Unused
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RJ-45 (network)

Pin Signal

1 Transmit +
2 Transmit -
3 Receive +
4 Unused

5 Unused

6 Receive -
7 Unused

8 Unused

Universal Serial Bus

1 2 3 4
I-_-_-_-.I

Pin Signal
1 +5VDC
2 Data -
3 Data +
4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions

The requirements listed below are applicable to all countries and regions:
e The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

e All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

e The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

e The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm? conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2.  The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm? conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

/A CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

Bf NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

99—

Bf NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.
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Perform the following steps to disassemble the display assembily:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.  Remove the display bezel (3).

4. Remove all screws (1) that secure the display panel assembly to the display enclosure.
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5. Remove the display panel assembly (2) from the display enclosure.

6. Turn the display panel assembly upside down.

7. Remove all screws that secure the display panel frame to the display panel.

8. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.

9. Remove the display panel frame (2) from the display panel.

10. Remove the screws (1) that secure the backlight cover to the display panel.
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11. Lift the top edge of the backlight cover (2) and swing it outward.

12. Remove the backlight cover.
13. Turn the display panel right-side up.
14. Remove the backlight cables (1) from the clip (2) in the display panel.

15. Turn the display panel upside down.

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
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16. Remove the backlight frame from the display panel.

__,._,._,._,.

17. Remove the backlight from the backlight frame.

18.
19.
20.
21.

Disconnect the display panel cable (1) from the LCD panel.

Remove the screws (2) that secure the LCD panel to the display rear panel.

Release the LCD panel (3) from the display rear panel.

Release the tape (4) that secures the LCD panel to the display rear panel.
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22. Remove the LCD panel.

23. Recycle the LCD panel and backlight.
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AC adapter, spare part
number 28
antenna, disconnecting 59
audio, product description 3
audio-in (microphone) jack
location 11
pin assignments 130
audio-out (headphone) jack
location 11
pin assignments 130

B
backing up, Windows Vista 124
backing up, Windows XP 128
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base enclosure, spare part
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removal 42
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precautions 36
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boot options 88
boot order 88
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power 9
QuickLook 8
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cables, service considerations 36
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buttons 8
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keys 9
left-side 13
lights 8
pointing devices 7
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TouchPad 7
computer feet
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accessing in Windows 84
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Linux 90
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using in Windows 84
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service considerations 36
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device configurations 88
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Windows 87
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Driver Recovery 129
Operating System 129
Disk Sanitizer 87
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precautions 36
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components 6
illustrated 6
display assembly
removal 60
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display bezel
removal 62
spare part number 17, 31, 62
display cable kit, spare part
number 31, 64
display component recycling 137
display components 6
display enclosure, spare part
number 16, 25, 31
display hinge
removal 63
spare part number 17, 31, 63
display panel, removal 63
display specifications 96
drive light 11
DriveLock password 86
DriveLock, automatic 87
Driver Recovery disc 129
drives
boot order 88
preventing damage 36
Dual-Core CPU 88
DVD-ROM Drive
spare part number
specifications 100
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spare part
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specifications 98
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E
electrostatic discharge 37
esckey 9
Ethernet, product description 3
Execution Disable 88
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external monitor port
location 13
pin assignments 131

F
f11 recovery 126
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removal 75

spare part number 18, 75
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spare part number 41
File menu

Linux 91

Windows 86
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front components 11
function keys 10
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graphics, product description 1

grounding equipment and
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hard drive
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product description 2
removal 53
spare part
numbers 22, 27, 31, 32, 33
, 34, 53
specifications 97
hard drive bracket, removal 54
hard drive recovery 126
HDMI port
location 13
pin assignments 132
headphone (audio-out) jack
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pin assignments 130

heat sink

removal 75

spare part number 18, 31, 75
hinge

removal 63

spare part number 17, 63

HP QuickLook 2 88

|

I/O address specifications 102
Info Center 8

internal display switch 6
interrupt specifications 101

J

jacks
audio-in 11
audio-out 11
headphone 11
microphone 11
modem (RJ-11) 12
network (RJ-45) 13

K
key components 9
keyboard
product description 4
removal 43
spare part numbers
keypad keys 10
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esc 9
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function 10
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L
language, changing in Computer
Setup 87
left-side components 13
legacy support, USB 84, 88
light components 8
lights
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caps lock 8

drive 11
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power 9
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Media Card Reader 11
memory map specifications 104
memory module
product description 2
removal 46
spare part number 34
spare part numbers 46
microphone (audio-in) jack
location 11
pin assignments 130
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pin assignments 133
modem module

product description 3
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packing guidelines 38
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port 134
plastic parts 35
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port options 89
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removal 68
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TouchPad buttons 7
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USB connector and cable, spare
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vents 13
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Windows recovery 125, 129
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DVD 127
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